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1. Welcome to COPA-DATA help

GENERAL HELP
If you cannot find any information you require in this help chapter or can think of anything that you

would like added, please send an email to documentation@copadata.com
(mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact
via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com (mailto:sales@copadata.com).

2. zenon Science Package for LEGO MINDSTORMS

The zenon Science Package for LEGO MINDSTORMS enables the programming of LEGO Mindstorms NXT
and MINDSTORMS EV3 z:icv. Programs are created in zenon Logic and executed on the LEGO Controller
with straton. zenon Logic is the programming environment in accordance with IEC 61131-3 included in
zenon.
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3 License information
The zenon Science Package for LEGO MINDSTORMS contains a limited license (for

details, see the zenon Science Package license (on page 8) chapter). This is installed if you
do not have a licensed zenon installation on the computer.

This instruction takes you through the installation and programming for the automation of a LEGO
Mindstorms NXT 2.0 or MINDSTORMS EV3 with zenon. Only information with regard to the
operation with zenon Logic/straton is contained in this documentation. Please find basic information on
the programming and operation of LEGO MINDSTORMS objects in the LEGO documentation.

All necessary software is included on the installation medium for zenon Science Package for LEGO
MINDSTORMS. This package does not contain any LEGO hardware, components or controls.

For the configuration of LEGO hardware with zenon use the following software:
» zenon: Software for monitoring and controlling which contains the integrated zenon Logic.

» zenon Logic Workbench: Programming environment for programs running on the embedded
straton firmware.

» straton: Firmware for the LEGO Controller.

Please find all required applications and information on the installation media. These should already
have been created in your zenon folder on the computer. The most important folders are:

» FIRMWARE: This folder contains the firmware you can load onto your LEGO MINDSTORMS
Controller with the LEGO Firmware Loader.

» USB_DRIVER: This folder contains the INF file for the USB-to-serial driver.



¥ Information

LEGO, MINDSTORMS, NXT and EV3 are trademarks and products of the company
LEGO.

3. zenon Science Package for Lego MINDSTORMS 2.0

The zenon Science Package for LEGO MINDSTORMS 2.0 enables the programming of LEGO Mindstorms
NXT 2.0 objects. Programs are created in zenon Logic and executed on the LEGO Controller with straton.
zenon Logic is the programming environment in accordance with IEC 61131-3 included in zenon.

3.1 Installation

For using the zenon Science Package for LEGO the following is required:
» zenon from version 7.00 SPO on

» Firmware (on page 9) for the LEGO Controller

If you have already installed zenon 7.00 or higher on your computer you will also have a license for using
the zenon Science Package for LEGO. If you haven't installed zenon yet install the zenon version from
the installation medium (on page 7). This is a limited License (on page 8) for using LEGO MINDSTORMS
2.0.

3.1.1 Install zenon

In order to install zenonin the current version:

1. Connect the installation medium to the computer

2. If the installation does not start automatically, select start.exe
3. selectzenon 7.20
4

follow the instructions of the installation wizard

Note: If you already have a zenon version from 7.00 on no installation is required.



zenon Science Package License

The zenon Science Package for LEGO MINDSTORMS 2.0 is contained in the zenon standard license. If this
version is installed on a system without zenon it will run with a zenon Science Package License. With this
license it is also possible to create and edit zenon projects within the scope of the licensed modules.

This license contains:
» 128 variables
» Extended Trend Starter Edition
» Historian Starter Edition
» VBA
» zenon Logic Workbench

» straton firmware

Note: This license is executable for 90 minutes. The Editor must then be closed and re-started.

3.1.2 Demo projects

You can also get two demo projects in the COPA-DATA Forum (www.copadata.com/forums
(http://www.copadata.com/forums)):

> 1 Gives an overview over sensors and controller. Use this project to become
familiar with LEGO MINDSTORMS 2.0 and its programming.

> : A sample project for the shooterbot. This can be adjusted to your needs.

Load the working area with both projects into zenon:
1. right-click on the current workspace
2. inthe context menu working space select -> read backup...
3. Go to the working area backup on the installation medium (* .wsb)
4.

select the file and click on ok

To open projects:
1. inthe working space go to node zenon Logic (IEC 61131-3)
2. select the node by left-clicking on it
3. select the project mindstorms
4

click on the symbol open in the toolbar or double-click on the project in order to open the
project in the zenon Logic Workbench
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3.1.3 Install firmware

In order to be able to use your LEGO MINDSTORMS 2.0 with zenon you have to load straton firmware on
the Controller. This chapter will show you how to:

» load straton firmware on the Controller

» update already existing (on page 10) straton firmware or replace other already existing
firmware

» create a USB connection (on page 11) with the Controller with the COPA-DATA USB driver

» establish a Bluetooth connection (on page 12) with the Controller

LOAD STRATON FIRMWARE ON THE CONTROLLER

In order to load straton firmware on the LEGO MINDSTORMS NXT 2.0 Controller the LEGO
MINDSTORMS NXT 2.0 software is required, which was delivered with your LEGO MINDSTORMS NXT
2.0.

& Attention

If on the Controller there already is a different firmware than the one delivered by LEGO
please proceed as described in section Dealing with already existing firmware
(on page 10).

In order to load the firmware:

1. Startthe LEGO MINDSTORMS NXT 2.0 software.

2. Inmenu Tools -> select Update NXT Firmware

[ e

L

3. Ensure that the correct format is used: * . rfw.
If the file suffix is still *.bin, change this to *. rfw.
In zenon 7.20, the file is called: STRATON_NXT_103_2011_08_10.rfw.
You can find this on the installation medium in the path: AdditionalSoftware\Science
Package - Firmware\NXT2.

4. Click on the Browse button.



5. Select the folder containing the firmware.

[5]] Update MXT Farmware s

LEGO HT Firmvears w105
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6. Start the NXT Controller.
To do so, press the orange button.

7. Connect the Controller via USB with the computer.

8. Click on the button pownload to load the firmware on the Controller.

[5]] Update NXT Firmware. —— Felﬂ‘l
I Last downboaded firmware:
[ rie Updates:
9 A valable Frmware Fies

‘ B
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Il . [ —
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9. Remove the USB cable.

10. The Controller starts with the updated firmware

¥ Information

In order to update the loaded straton later on or replace it again with firmware by LEGO

follow the instructions in section Dealing with already existing firmware (on
page 10).

3.1.4  Dealing with already existing firmware

If firmware not provided by LEGO is already present on the Controller this has to be set to the Firmware
load mode in order to be able to install other firmware. This mode is also required if the straton
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firmware is supposed to be updated or LEGO firmware loaded again. In order to set the Controller to

Firmware load mode:
1. Press for at least 5 seconds until you hear a quiet clicking noise
e both the orange start button and

e the Rest button on the back of the device.
You can best reach the Rest button with a pointed object.

3. The NXT Controller starts in the Firmware load mode . You can hear a regular sound.

4. Start the download of the desired firmware.
To do so, a connection via USB (on page 11) or Bluetooth (on page 12) must be established. For
the USB connection with zenon/straton the COPA-DATA driver is required.

& Attention

The Firmware load mode can only be closed by downloading a firmware.

USB connection without LEGO firmware

If the firmware applied is not provided by LEGO probably the corresponding driver must be installed. In
this case the USB Controller is not recognized during the connection with the computer. To establish a
USB connection:

1. Open the System control -> System -> Device manager.
2. Double-click on Unknown device.

3. Inthe tab briver click on update driver.

4

The dialog for selecting the driver is opened.

11
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3.15

Select search the computer for driver software.
Select the folder containing the Mindstorm_straton.inf .
A warning regarding the driver manufacturer is displayed.
Select Install driver nevertheless.

The device can now communicate via USB.

Establish a Bluetooth connection with the Controller

If the computer is provided with a Bluetooth port the connection with the Controller can also be
established via Bluetooth. In order to configure Bluetooth for the connection between computer and
Controller:

1.

© © N o

Switch on the LEGO Controller by pressing the orange button.

Press the orange button again.

Select settings with the right gray arrow button.

Confirm selection by pressing the orange button.

Go to the menu for Bluetooth settings by using the gray buttons .
a) Activate Bluetooth.

b) Assign a Bluetooth name.

c) Setthe Bluetooth statusto visible.

d) Leave the Bluetooth menu by clicking on the dark gray button.
Change to menu Connections.

Select Bluetooth using the gray buttons.

Now the Controller can be found via Bluetooth.

Open the Bluetooth device manager on the computer.

a) Select Add device.

b) Windows will search for visible Bluetooth devices.

12



10.
11.

3.2

c) Select your MINDSTORMS NXT Controller from the list and click on Next.

d) The MINDSTORM Controller requires to enter a password for establishing the connection:
1234_is suggested. Confirm the password by pressing the orange button.

e) The password defined in the MINDSTORMS 2.0 Controller must also be entered on the
computer.

f) Click on Next.
The connection is being established and the drivers are being installed.

Double-click on the created Bluetooth device.

The installed device and the assigned COM port are displayed. Connect the zenon Logic
Workbench with this COM port or connect zenon with the stratonNG driver.In order to adjust
the port:

a) Click on properties.
b) Click on the advanced button.

c) Change the port number according to your specifications.

Create a connection between zenon Logic and straton

In order to create a connection between zenon Logic and straton:

1.

Start zenon. The project MINDSTORMS is opened.

If you would like to open a different project or working area open the working area for the
project via the context menu for the working area.

If you would like to create a new project:

a) select the file -> Project new

b) create a new zenon Logic project by first right-clicking on the node zenon Logic and then
selecting in the project tree zenon Logic Project new...

Open the zenon Logic project by double-clicking in the Workbench.
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3.

4. The dialog options with the tab pebug is opened in order to configure the connection.

5.

In the zenon Logic Workbench click on Tools -> communication parameter.

Fenster Hilfe

% Optionen...

HTML-Dokument erstellen...
Monetering Applikation erstellen...
Historie...

Globaler Binding Editor

Projekte vergleichen

®mse

Kommunikations-Parameter...

Runtime Parameter 3

Importieren...

Exportieren...
Programm konvertieren 4

Automationsscript..,

Click on the button ... in order to open the dialog for the settings of the serial communication.

Kemmunikationsparameter

" Ethemet TCP/P
IP Adresse:

Part:

+ Serielle Yerbindung

JW

PC Part: Com1 -
Baudrate: 15200 hd
Paritat: ’m
Stoppbits: m

14



3.2.1

Configure the serial setting corresponding to the settings for the LEGO Controller.

Note: In this dialog only COM ports 1 to 4 can be selected. However, in the dialog options tab

Debug you can enter the COM port directly in to the field communication parameter.

Optionen ==
' Zielsystem | Runtime | Compder | Download Debug | Online Change | “C*14 ] *|
|c:\ProgramData\COPA DATA\SQL2008R2\ac 39 lied- A73-dcebbdda-eeT: ~ |

Kommunikationsparameter
[EIE10) ]
[ 5 Rurtime |

Simudation for alle Projelde)
[ Simulateor immer im Kalstart Modus starten

Verbunden mit Rurtime §ur alle Projekts)

™ Bestatigen vor dem Stoppen der Applikation

™ Bestatigen vor Download

[~ Bestatigen vor OnlineChange
Beim Starten der Runtime fur alle Projekte)

* Vorschlag im “Kaktstart"-Modus zu starten

" Vorschlag mit geladenen RETAIN Variablen zu startten
Misc

[™ User-Aktionen wahrend Test aufzeichnen

Log-Datei anzeigen... |

[ Aiways open this tab

oK I Abbrechen | Hilfe: |

You will thus have configured the connection between zenon Logic and straton.

Add NXT driver in zenon Logic

In order to add the NXT driver in zenon Logic:

1.

In the project tree in the zenon Logic Workbench double-click on Fieldbus configuration.

15



2. Inthe window I/O driver click on the symbol or the command in the context menu for add
configuration.

B e — T T S — —
Gle Ede View Imet Propct Tooks Wndow Mep
o 3 a2 B HE%NED B'eA
Vorkspace
J mt B Narve
4 Gk
3 Progam
4 Flecpe
3 Sgnes
3 SohScope
2 oy
23 Svng Tavies
B Fiktbus Cordgpasions
%y Bedeg Conkoursson
© Pookies
m vos feut
3g Globsl detre:
(3 Global vansbies
B Ixe

g o B

3. The dialog for configuration is opened.

Add Configuration l fomtm
Choots & configursinon
0K
[Fdscher CF Profns = :I
Hitscher SYCON confiu Cancel

Hitzcher SYDON net configuation (L]
|EC BOST0 Slave
|EC 61850 Chent
|EC B1850 Serves incl GOOSE
Irberbus-S

50 Mindshoms
MODBUS Master protocol
MODBUS Slave protocol
PROFINET 10 controller
FROFINET 10 device E
Solthet ProtbusDP
shiaton bo 2enon Runtme connechon
Wiage T58-87x |0 Sysber / Thkl D
wago Linuo: Conirolier
Widerislephan slandard - Chert
Win32 Shared memony
#Flowr

4. Select LEGO Mindstorms NXT 2.0.
5. There are three sections:

e  NXT (Status)

e Drives

e Sensors

Clicking on the plus (+) before the section opens a subarea. For each of these sections
predefined variables can easily be created.

CREATE VARIABLES

Create the required variables:

16



1. Right-click on the branch NXT, Drives or Sensors.

L — —
adow  Help

I #hod % %W%e A G R

O LEGO Mindstomns NXT 20
& 0
"8 Ststur
& Doves
"B Pt A
"8 Pt B
"B Pt C
& Sensors
"8 Pet
"8 Pet2
"8 Pet3

afg pi—

& Broperies..

_——
Name find... Bt number
Find Next

Insest Configuration...

o lInsert Variable..
B¢ Sort symbols
33 Gnd Crl+ G

Creste variables

2. Select create variable in the context menu.

DRIVES
There are two versions: easy and advanced. As a start it is best to select easy and then create

variable. Please find more information on the use of Advanced Variables in section Use of complex
variables (on page 39).

SENSORS

Before creating a variable in section sensors a sensor type in field Type must be selected. To do so,
double-click on the field value.

O Ma%e D Fad

&) 9 LEGO Mrsdormr hE4T 210 Hars
i 1T Tiee

@ STATUS_BETTERTWOLTAGE
aTTE

|
@ STATUS RECHARGEABLE
= STATUS_ERADA

PN L




CONFIGURATION EXAMPLE:

3.2.2

Connect NXT Controller

In order to connect the NXT Controller:

1.

On the Controller select usB as connection medium:
a) Press the orange button.

b) Use the gray buttons to go to the menu Settings and open it by pressing the orange
button.

c) Select Connection.

d) Select uss.
(If you would like to connect via Bluetooth select BlLuetooth.)

Compile the zenon Logic project:

a) Right-click on mindstorms in the project tree.

b) Select compile project in the context menu.

Go online:

a) Select the entry online in the zenon Logic menu Project.

b) The request for download is opened:

Mo application [
| Do-you want to download the application now?
Yes I HNo

c) Click on Yes.

18



4. The project is online and you can watch how the sensors read values.

3.2.3  Controller basic settings

BASIC CONFIGURATION

1. Configure the communication settings (details see following section: Settings).
2. Activate or deactivate Bluetooth (details see following section: Connection).

3. Incase of active Bluetooth: Assign a unique name for the Bluetooth communication.

OPERATION

SWITCH ON

In order to switch on the Controller press the orange button.

MENU NAVIGATION

» Open menu: Press the orange button.
» Close menu: Press the dark gray button.

» Navigate in the menu: Press the left or right gray arrow button. Select a menu entry with the
orange button. In order to leave a submenu without saving press the dark gray button.
SWITCH OFF

1. Select Turn off in the main menu and press the orange button.

2. Select an option:

19



c)

save: Saves all settings on the flash memory and closes the Controller. The currently loaded
straton application, retain data and the configuration (Connection, Volume) are saved on
the flash memory.

Don't save: The application is saved without saving data or configuration on the flash
memory.

Cancel: Saving is cancelled and the main menu opened.

During the next start the data saved last (straton application, retain data etc.) are loaded.

STRATON MENU

With the straton menu you can start or stop the loaded straton application. In order to open the menu
select the entry straton in the main menu.

STATISTICS

Statistics displays information on the currently running application. In order to display the
corresponding data select the entry Statistics in the main menu. The following is being displayed:

» the name of the loaded application

» codesize in kB

» database size in kB

» the execution time of the straton cycle

» the cycle latency in microseconds

MENU SETTINGS

In this menu the following is configured and displayed:

» Versions: Information on the version used.

» Bluetooth: Bluetooth activation or deactivation. Name and contacts can be managed.

Name: Enter a name for the Bluetooth device. The name should be unique in the Bluetooth
network.

on/0ff: Activates/deactivates Bluetooth at the Controller.
Visibility: Determines if the device is visible for other Bluetooth devices.

Search: Starts search for Bluetooth devices. In order to add a device to the Bluetooth
contacts select it from the list of devices found.

Contacts: Manage contacts. You can remove contacts (devices which may be connected)
or establish connections (e.g. for pairing).

20



CONNECTION

Select the connection to be used by the straton communication server. Connection for the
communication with the zenon Logic Workbench. The communication server also includes a MODBUS
slave. The zenon driver for straton must also be connected with the communication server. Possible
options are:

» USB
» Bluetooth: incoming Bluetooth connection

» Rs-485: RS-485 port with the parameters 115200, E, 8, 1
Attention: Using RS-485 deactivates the sensor port 4. Please also bear in mind that the straton
communication server protocol can only be used point-to-point.

» None: The communication server is not used.

VOLUME

Defines the volume of the built-in speakers. Valid values are 0 to 4, with:
» 0:switched off

» 4: Maximum

3.3 Develop straton applications for NXT

The following restrictions apply for straton applications on LEGO MINDSTORMS 2.0:

STRATON RUNTIME:

» Maximum size of code: 26 kB

» Maximum size of straton database: 20 kB

Note: Size of code and database can be checked in the menu statistics.

ZENON LOGIC WORKBENCH

» Only COM ports 1 - 9 can be used. If a USB device or a Bluetooth COM port was assigned a
higher port number than 9 this has to be manually configured to a port number lower than 10.

» Inthe Workbench only ports COM1 — COM4 can be selected. However, port numbers can be
entered directly into the parameter string, e.g. coM9:19200,N, 8,1. (See also section Establish
connection between zenon Logic and straton (on page 13).)

Note: In case of a USB or Bluetooth connection it is sufficient to enter the port, e.g. coMs

21



¥ Information

Please find general information on the programming of LEGO MINDSTORMS NXT 2.0 in
the LEGO documentation.

33.1 Use NXT communication ports

NXT objects contain three communication ports which can be addressed by the straton application.

With the menu settings (on page 19) one of these connections is selected for the communication
server. This connection can subsequently not be used out of the straton application (e.g. by a MODBUS
Master or a function block). However, if a MODBUS Slave configuration was added a MODBUS Slave can
use the configured port.

Please find further information on the use of the serial port in the straton program and on the MODBUS
I/O driver in the zenon Logic documentation. To do so, in the Workbench press the key F1 or use the
menu Help.

All ports which are not being used by the communication server can be used by the straton application
and are addressed as follows:

usB

The NXT component can be connected with a computer via the USB port. NXT is recognized as serial
connection by the computer.

The USB port can be addressed by the straton application by selecting USB as COM port.

r N
MODBUS Master Port oS
" MODBUS on Ethemet [ o
Address: 127 Cancel
Port: 502
Protocol: F
& Serial MODBUS-RTU

—_—
Com. port: |USB:

Delay between requests

Delay (ms): |0

¥ Try to reconnect after communication error
¥ Manage gagnostic info for slaves

L
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Bluetooth

The Bluetooth port can be used in two different ways:

1. Forincoming connections:
in this case the connection is established from a remote device, e.g. a computer. In this case the
string BT is sufficient in order to use the Bluetooth port.

2. For outgoing connections:
NXT is configured in order to establish a connection with another Bluetooth device, for instance
another NXT object. In this case use a string beginning with BT and ending with the name of the
device, for instance: BT : NXT.
Note: The device to be addressed must already be contained in the Bluetooth contacts. In order
to manually add a device to the contacts start the Search (on page 19) and manually establish
the connection once. For the first contact a pairing is probably required.

RS-485 Port (serial)

NXT objects also contain a serial RS-485 port. It is however shared with sensor 4. Thus only the port or
the sensor can be used.

The RS-485 port is addressed via character string gs. With this the port is opened with the help of the
following parameter per default:

» Baudrate: 115200 bit/s
» Parity: even
» Data bits: 8

» Stop bit: 1

ADAPT PARAMETER

If you want to adapt the communication parameters, add them after the colon separated by commas.
The order:

» Baud rate in bits/s

» Parity: N (none), E (even), 0 (odd), M (mark) and s (space)

» Data bits

» Stop bit

For example: HS:19200,N,8,1

Note: If you use the RS-485 port with MODBUS or the straton protocol, always set Data bits to 8.

23



Fieldbus

With straton NXT it is also possible to use the MODBUS Slave and MODBUS Master configuration. Please
find information on MODBUS in the zenon Logic documentation. To do so, in the Workbench press the
key F1 or use the menu Help. The use of NXT sensor and motor ports are configured in the LEGO
MINDSTORMS NXT 2.0 configuration.

10 Drivers *
B 1 LEGO Mindstorms NXT 2.0

& B e

= [ Status

; t STATUS_BATTERYWOLTAGE
= th STATUS_BATTERYSTATE
g & STATUS_BLUETOOTHSTATE
3 e STATUS_USBSTATE

: @ STATUS_RECHARGEABLE
b t STATUS_ERROR
o Dirves
B 0 Potd

@ PORT_A_AUTOSPEED
& PORT_A_TACHOCOUNT
0 PotB
B PatC
= Senzors
B Poit 1: Touch senzor
& PORT_1_VALUE
B Pot 2 Ulirasonic senso
& PORT_2 VALUE
@& PORT_2 INVALID
B Pot 3 Light sensor [active)
& FORT_3_VALUE
& PORT_3_INVALID
B Pot 4 Colour sensor
oy FORT_4_VALUE
& PORT_4_RED
& PORT_4_GREEN
y PORT_4_BLUE
t PORT_4_GRAY
& PORT_4_INVALID
@ FORT_4_COLOR

Status variables

The following status variables are available:

EREG
E Status

@ STATUS_BATTERYWOLTAGE
@ STATUS_BATTERYSTATE
@ STATUS_BLUETOOTHSTATE
@ STATUS_USBSTATE
@ STATUS_RECHARGEABLE
@ STATUS_ERROR

» STATUS BATTERYVOLTAGE: current battery charge in millivolt.

» STATUS_BATTERYSTATE: Battery capacity.
Value: 0 to 4 (as displayed on the NXT display)

» STATUS BLUETOOTHSTATE: Bluetooth status
Values:

° 0:0n

e 1:visible

24



e 2:connected
e 3:connected and visible
e 4:0ff

» STATUS_USBSTATE: USB status
Values:

e 0:disconnected
e 1:connected
e  2:operating

» STATUS RECHARGEABLE: Status for rechargebale batteries
Values:

e 0: Norechargeable batteries existing
e 1: rechargeable batteries existing

» STATUS_ERROR: Error code

Drive Variables

The following variables are available for the drive:
o® Diives
[ Pot: A
@ PORT_A_AUTOSPEED
@& PORT_A_TACHOCOUNT

» PORT_x_AUTOSPEED (SINT, Output): Defines the motor speed.
Values: from -100 to 100

e  0: Motor off
e -100: Maximum speed backward
e 100: Maximum speed forward

» PORT_x_TACHOCOUNT (DINT, Input): Contains absolute number of motor revolutions in angular
degrees. 360° are one complete revolution per second. Valid values: from -2,147,483, 648 to
2,147,483,647.

COMPLEX VARIABLES

More complex drive operations are configured with more complex variables. Select them in the entry
Create advanced variables in the context menu.
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A Attention

Do not use the AUTOSPEED variable and the Advanced Variables at the same time. Using
them at the same time may result in an undefined behaviour of the drive.

o® Drives

F Port A

E Pot B
g PORT_B_TACHOCOUMNT
g PORT_B_BLOCKTACHOCOUNT
g PORT_B_ROTATIONCOUNT
W PORT_B_TACHOLIMIT
W PORT_B_FLAGS
W PORT_B_MODE
W PORT_B_SPEED
g PORT_B_ACTUALSPEED
W PORT_B_REGPPARAMETER
W PORT_B_REGIPARAMETER
W PORT_B_REGDPARAMETER
W PORT_B_RUNSTATE
W PORT_B_REGMODE
g PORT_B_OVERLOADED
W PORT_B_SYNCTURNPARAMETER

Please find a description on how to configure these variables in section Using complex variables (on
page 39).

Color sensor variables

The following variables are available for the color recognition:

W= Senzors

1 Port 1: Colour sengor
gy PORT_1_WALUE
@y PORT_1_RED
g PORT_1_GREEM
& PORT_1_BLUE
& PORT_1_GRAY
@ PORT_1_INVALID
iy PORT_1_COLOR

» PORT_x_COLOR (INT, Output): Defines the sensor mode.
e  0:Passive mode (measure brightness)
e 1:Redis being measured.
e 2:Green is being measured.
e  3:Blueis being measured.
e  4:All colors are being measured
» PORT_x_VALUE (INT, Input)
If the mode is passive, red, green orblue:
e Avalue between 0 and 255 defines the color intensity.

If the modeisall colors:
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: black
: blue
: green

. : red

1
2
3
o 4:yellow
5
e 6:white
» PORT_x_RED:Inthe mode all colors the intensity of the color red is measured.
» PORT_x_GREEN:Inthe mode all colors the intensity of the color green is measured.
» PORT_x_ BLUE: Inthe mode a1l colors the intensity of the color blue is measured.

» PORT_x_GRAY: Brightness is measured

Touch Sensor Multiplexer (HT)

The following variables are available for the touch sensors:

&= Sensors
[d @ Fort 1: Touch sensor multiplexer [HT]
& PORT_1_SWITCH1
& PORT_1_SWITCH2
& PORT_1_SWITCH3
& PORT_1_SWITCH4

When using the HiTechnic Touch Sensor Multiplexer up to four sensors can be connected with a NXT
port:

» PORT_x_SWITCH1: Status of sensor 1
» PORT_x_SWITCH2: Status of sensor 2
» PORT_x_SWITCH3: Status of sensor 3
» PORT_x_SWITCH4: Status of sensor 4

Gyroscopic sensor (HT)

The LEGO MINDSTORMS 2.0 NXT Gyro Sensor gives information on the number of motor revolutions
and the direction of the revolutions. The revolutions are measured in angular degrees. 360° are one
complete revolution per second.
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After the start of the straton application the sensor is automatically calibrated during connection. To do
so, the current zero value is calculated. This takes about 200 ms. During this period of time the sensor

must not be moved.

[l Port 2 Gyroscopic sesnor [HT)
g PORT_2_WALUE
@ PORT_Z_INVALID

» PORT_x_VALUE: Number of angular grades per rotation second
» PORT_x_INVALID: Set to TRUE when:
e the sensor is being calibrated

e the value cannot be read

Digital Acceleration Sensor (HT)

The LEGO MINDSTORMS 2.0 NXT acceleration sensor includes a 3-axis accelerometer measuring
acceleration in the three axes x, y and z. The acceleration is displayed within the scope of -2g to +2g

with approximately 200 steps per g.

The acceleration sensor can also be used to measure the gradient in three axes. This is possible because
gravitation is perceived as acceleration. If the sensor is motionless in the normal horizontal position the
x-axis and y-axis, being horizontal, will be close to zero, while the z-axis' value will be close to 200,
corresponding to 1g. If the sensor is then inclined the other axes will also perceive gravity and the
z-axis' value will decrease. Since gravity is divided among the three part vectors the gradient of the
sensor can be determined.
[l Port 3: Digital Accelerometer senzor [HT)
@& PORT_3_WalLUE_x
@& PORT_3_WalLUE_ v

gy PORT_3_WALUE_Z
@ PORT_3_INVALID

» PORT_x_VALUE_X: Acceleration in direction of the x-axis
» PORT_x_VALUE_Y: Acceleration in direction of the y-axis
» PORT_x_VALUE_Z: Acceleration in direction of the z-axis

» PORT_x_INVALID: Set to TRUE if the data of the sensor cannot be read.

28



Digital Compass Sensor (HT)

The LEGO MINDSTORMS 2.0 NXT Compass Sensor contains a magnetic digital compass to measure the
earth's magnetic field and calculate a heading angle. The Compass Sensor can be connected to a NXT
port with a NXT standard cable and uses the digital I2C communication protocol. The current heading is
calculated to the next integral angular degree.

The HiTechnic Compass Sensor is influenced by local magnetic interferences, as is any other magnetic
compass, too. Metal objects such as motors, batteries or cables may cause magnetic interferences. Local
magnetic interferences may cause the compass to produce a heading deviating several degrees from the
current magnetic heading. This effect is called compass deviation. In order to correct this deviation the
HiTechnic Compass Sensor has a built-in calibration function correcting deviations and saving these
values in the compass.

The calibration is optional and usually not required during normal operation. In order to minimize the
need to calibrate install the compass in a distance of at least 10 to 15 cm (4 - 6 inches) to NXT and the
NXT motors.

In order to calibrate the compass in the program:
» Select calibration mode.
» Program your NXT object so that it rotates within a very narrow circle.
» It must rotate between 1% and 2 times (more than 360 degrees).

» It must complete a full turn in approximately 20 seconds.

The compass will maintain the calibration settings until another calibration is made, even though it is
being unplugged.

El Port 4: Digital compass sensor [HT)
g PORT_4_VALUE
@ PORT_4_INVALID
Wk PORT_4_CAL

» PORT_x_VALUE: Current heading in degrees.

0: North
» PORT_x_INVALID: Set to TRUE if the data of the sensor cannot be read.
» PORT_x_CAL: (Display) Controls the calibration mode.

e TRUE change to calibration mode

e FALSE: changeto measuring mode.

Note: In the calibration mode the sensor provides invalid data.
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Other sensors

The following additional variables for sensors are available:

@ Sensors
o
[l Poit 2 Sound sensor [dBA)
g PORT_2_WALUE
@ PORT_2_INVALID

» PORT_x_VALUE: sensor value, depends on sensor

e SounddB

e Sound dBA

e Ultrasonic: distance in centimeters (cm)

¢ Temperature: temperature in Celsius centigrade (°C/10)
» PORT_x_INVALID:

e TRUE: sensor isin error status

3.3.2 Functions

In order to select functions these must be located in the corresponding folder. Copy the Mindstorms
NXT folder from the HWDEF folder on the installation medium into the HWDEF  folder of your straton
installation.

For example:
$ProgramData$\COPA-DATA\zenon7.20711\straton\HWDEF\Mindstorms NXT

AN
3 Embedded HMI
[ Files
[ Hilzcher CIF
1 Hilscher CIF PB
3 IECE1850
[ Maths
[ | Mindstorms M
I} BUTTOMEMAELE
I} BUTTOMNGET
I} DISPLAYERASE
I} DISPLAYLINE
T} DISPLAYPIXEL
I} DISPLAYSTRING
1T SOUNDFREQUENCY [*Flay a tone®)
1 Miscellaneous
3 Mo
3 PC_CE
3 PID
1 Plus!
1 Rengisters

The following functions are available:

» BUTTONENABLE (on page 31): straton takes over control of NXT buttons.
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» BUTTONGET (on page 31): Transmits information on which button was pressed.
» DISPLAYERASE (on page 32): Erases screen content.

» DISPLAYLINE (on page 32): Draws a line.

» DISPLAYPIXEL (on page 32): Draws a pixel.

» DISPLAYSTRING (on page 32): Writes a string.

» SOUNDFREQUENCY (on page 33): Sound output.

BUTTONENABLE

BOOL BUTTONENABLE (BOOL ENABLE)

During the activation with ENABLE and status TRUE the control is being passed on to straton using the
buttons on the NXT object. The button status can be read with BUTTONGET (on page 31).

Note:
» The menu systemon the NXT object is deactivated in this case.
» Activating this function is only possible if the menu on the NXT object is inactive.

» This status can be interrupted, for instance by a Bluetooth pairing dialog. In this case
BUTTONGET (on page 31) returns the value -1.

Response value:

» TRUE: Activity successfully completed.

BUTTONGET

SINT BUTTONGET

Return values:
» -1:buttons cannot be read by straton. The menu system on the NXT object is activated.
» 0:no button pressed.
» 1:left button pressed.
» 2:button Entry (orange button) pressed.
» 3:right button pressed.

» 4:button Leave (dark gray button) pressed.
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DISPLAYERASE

BOOL DISPLAYERASE
Erases the screen contents.

Response value:

» TRUE: Activity successfully completed.

DISPLAYLINE

BOOL DISPLAYLINE (USINT X1,USINT Y1,USINT X2, USINT Y2, BOOL C)
Draws a line from point x1, Y1 to point X2, ¥2.

Values for C:
» TRUE: drawsa line

» FALSE: erases the line

Response value:

» TRUE: Activity successfully completed.

DISPLAYPIXEL

BOOL DISPLAYPIXEL (USINT X, USINT Y, BOOL C)
Draws a point with the coordinates x, .

Values for C:
» TRUE: draws a point

» FALSE: erases the point

Response value:

» TRUE: Activity successfully completed.

DISPLAYSTRING

BOOL DISPLAYSTRING(USINT X, USINT Y, STRING TEXT)
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Writes a string beginning with the indicated XY position.

Response value:

» TRUE: Activity successfully completed.

SOUNDFREQUENCY

BOOL SOUNDFREQUENCY(UDINT FREQ, UDINT DUR, USINT VOL)

Plays a tone with the indicated frequency in Hz during the defined length in milliseconds. The volume
(VOL) is indicated in a range of 1 to 4. It is limited by the configured maximum volume (on page 19) in
the menu volume.

Response value:

» TRUE: Activity successfully completed.

3.4 Connect MINDSTORMS 2.0 Runtime with zenon

For creating a new zenon Logic project in zenon it is recommended to use the stratonNG driver. This
supports serial communication.

When creating a new zenon Logic project in the dialog define the name of the project and the driver
used.

zenon Logic Projekt erstellen @

Einstellungen
Name
MINDSTORMS|

Treiber
STRATONNG -

Fertigstellen [ Abbrechen ] | Hilfe |

Select STRATONNG from the drop-down menu.

Note: The selection of the driver cannot subsequently be changed again.
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CONFIGURATION OF STRATONNG DRIVER

To configure the driver:
1. inthe zenon project tree select the node variables -> Driver

2. highlight the stratonNG driver
Note: this is displayed with the name defined for the project, e.g. straton: mindstorms

3. selectbriver configuration in the context menu
4. the dialog for the driver configuration is opened

5. open the tab Connections

Konfiguration [t
Allgemein I Options | Connections
Connections Edit connection oK
Connection name
‘ Connection name | Abbrechen
mindstorms COMS: [ Hife
Addressing
Primary IP address Primary port no.
COM5
Secondary IP address Secondary port no
Error handling
Comunication timeout Reconnect delay
2000 ms 20000 ms
Options
Use muttiple connections
Ne (single connectio
Use evert connection
Disabled {polling only
Max. write request length
512
ime
New Delete Edt ‘

To edit the driver:
1. highlight the connection name
2. Clickon Edit.
3. configure the link

4. click on save and then ok

Configuration of the driver for the connection within the scope of LEGO MINDSTORMS 2.0:



Option Description
Connection name Must correspond to the project name.

If the name is different from that of the project this will result in errors during
the connection with the Controller.

Addressing In the communication with straton NXT via USB or Bluetooth it is sufficient to
set the port without further settings, e.g. COM5:

Primary IP address Entering COM port.

Entries beginning with COM and ending with a colon are interpreted as COM
ports.

Attention: The colon (:) must be present at the end of the port definition.
Otherwise it is not possible to establish a connection.

If no further parameters are indicated the standard configuration of the COM
port is used:

» Baud rate: 115200 bit/s
» Parity: even

» Data bits: 8

» Stop bit: 1

If you want to adapt the communication parameters, add them after the
colon separated by commas. The order:

» Baud rate in bits/s

» Parity: N (none), E (even), O (odd), M (mark) and S (space)
» Data bits

» Stop bit

For example: comM5:19200,N, 8,1

Limitations: If a COM port is indicated it is not possible to use:
» Event connection

» Multiple connections (more than one connection with a driver)

The documentation of these settings refers to the communication in the scope of LEGO MINDSTORMS
2.0. Please find details on the general configuration of the stratonNG driver in the online help (F1) in
chapter stratonNG (stratonNG.chm::/27853.htm).

3.5 Questions and answers

The most common questions regarding installation and operation of LEGO MINDSTORM with straton
and the zenon Science Package.
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Question

Why is an error message displayed during
installation?

How do | change back to the original LEGO
firmware?

How can | proceed if the LEGO Firmware Loader
does not find the Controller?

How do | proceed if the zenon Logic Workbench
driver does not communicate with my
Controller?

How do | proceed if the stratonNG driver does
not communicate with my Controller?

Answer

Probably there is already a zenon installation present in
the system.

Use the existing installation.

Details: Error message during the installation of the zenon
Science Package (on page 36).

Changing back corresponds to the proceeding during the
installation of the straton firmware if other firmware
already exists.

Details: Activate original LEGO firmware (on page 37).
Change the USB port or re-install its driver.

Details: LEGO Firmware Loader does not find the
Controller (on page 38).

This may have several causes. Check the settings and if all
devices are online.

Details: zenon Logic Workbench driver does not
communicate with the Controller (on page 38)

This may have several causes. Check the communication
parameters, the Runtime and the project.

Details: stratonNG driver does not communicate with the
Controller (on page 39).

Further questions and answers can also be found in the COPA-DATA user forum:
www.copadata.com/forums/ (http://www.copadata.com/forums/).

3.5.1

Error message during the installation of the zenon Science Package

An error message is displayed during the installation of the zenonScience Package which refers to an

already existing installation.

HINT -~ 2

The zenon development environment is already installed on this
0 computer. You cannot install it again!
You can adapt the installation in the Windows Control Panel in the
section Software.

0K

This zenon version has already been installed on your system. You don't have to install zenon and can
use the existing version. Import the demo projects (on page 8) from the installation medium and

continue with Install firmware (on page 9).
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3.5.2  Activate original LEGO firmware

If firmware not provided by LEGO is already present on the Controller this has to be set to the Firmware
load mode in order to be able to install other firmware. This mode is also required if the straton
firmware is supposed to be updated or LEGO firmware loaded again. In order to set the Controller to

Firmware load mode:
1. Press for at least 5 seconds until you hear a quiet clicking noise
e both the orange start button and

e the Rest button on the back of the device.
You can best reach the Rest button with a pointed object.

3. The NXT Controller starts in the Firmware load mode . You can hear a regular sound.

4. Start the download of the desired firmware.
To do so, a connection via USB (on page 11) or Bluetooth (on page 12) must be established. For
the USB connection with zenon/straton the COPA-DATA driver is required.

A Attention

The Firmware load mode can only be closed by downloading a firmware.

DOWNLOAD OF THE LEGO FIRMWARE:
Connect the Controller via USB with the computer.
Start the LEGO MINDSTORMS NXT 2.0 software.

In menu Tools select the entry Update NXT Firmware.

The original LEGO MINDSTOMS NXT firmware is preselected.

vk wN e

Click on the button Download.
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6. The Controller restarts with the original LEGO firmware.

3.5.3 LEGO Firmware Loader does not find the Controller

If the LEGO Firmware Loader does not find the Controller connect the USB cable with a different USB
port By doing so the USB driver is installed for the Firmware Loader mode.

If this does not solve the problem deinstall the driver. To do this:
1. Open the device manager in the system control while the Controller is connected.
2. Selectthe LEGO MINDSTORMS NXT Firmware Update Mode driver.

3. Right-click on it.

4. Select Deinstall in the context menu.
5. Remove the USB cable from the LEGO MINDSTORMS 2.0 Controller and reconnect it.

6. The driver is automatically reinstalled.

3.5.4  zenon Logic Workbench driver does not communicate with the
Controller

The communication with the Controller is a point-to-point communication via a virtual serial port. It i
only possible to connect one application at a time.

If the communication fails there might be several reasons. The most frequent include:
1. The stratonNG driver and zenon are still online.

2. The COM port settings are incorrect. Select the correct COM port settings in the menu
Communication parameters (on page 19).

S
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3. The connection settings for the Controller are not set to the correct medium (USB or Bluetooth).
Select the currently used connection.

3.5.5 stratonNG driver does not communicate with the Controller

The communication with the Controller is a point-to-point communication via a virtual serial port. It is
only possible to connect one application at a time.

If the communication fails there might be several reasons. The most frequent include:
1. The zenon Logic Workbench is still online.
2. The COM port settings are incorrect.

3. The straton Runtime has not been started on the LEGO MINDSTORMS 2.0 Controller.
In order to start the Runtime:

a) Pressthe orange button.
b) Assoon as you see the entry straton press the orange button again.
c) Select start and press the orange button.

You can tell that the Runtime is running when the square symbol next to the battery status is
rotating.

4. The straton project was not downloaded to the Controller.
If a project was downloaded please check if it is the correct project.

5. The symbol names of the variable have not been activated.

6. The connection name (on page 33) of the stratonNG driver is not identical with the name of the
zenon Logic project.

7. The connection settings for the Controller are not set to the correct medium (USB or Bluetooth).
Select the currently used connection.

3.6 Use of complex variables

This section explains how to control a motor with complex variables.
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¥ Information
The use of complex variables is only recommended for experienced users!

With an additional programming you can make the NXT motors move by a predefined angle. This is
required in order to engineer very precise movements. For engineering:

1. Create all variables by right-clicking on the port and selecting create advanced variables in the
context menu.

B [ LEGO Mindstoms NXT 20
B wxr
o® Drives

0 PotA

o

O Pot| E§' Properties...
¥ Sensors

o Pot ©

O Pot

B Port

O Port

EN L T

Find...
#, Find Next

B  Insert Configuration..

o Insegt Variable..
B¢ Sort symbols
H Grid Ctrls G

Create variables

Create advanced variables

2. You receive 15 variables.

The variables relevant for you are:
» PORT_n_FLAGS
e  Bit mask from which variables should be written.
» PORT_n_TACHOLIMIT
e The relative limit for the degrees with which the motor is supposed to rotate.
e Attention: This value is always positive, even if the motor rotates backwards.
» PORT_n_MODE
e  Mode the motor is supposed to use.

e Does not refer to forward or backward or increasing or decreasing speed, but to internal
commands.

» PORT_n_SPEED

e  Motor speed.

e Range: -100 (backward) to 100 (forward)
» PORT_n_RUNSTATE
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e How the motor is supposed to run.

e  Physical properties (set speed instantly, Ramp UP or Ramp DOWN)

A Attention

All variables must be written in a cycle!

That means: The variables cannot be forced from the zenon Logic Workbench.

STRUCTURE

Internally, NXT uses a structure. Create all variables of this structure by right-clicking on the port and
selecting create advanced variables in the context menu. This structure is written in every cycle.
However, since PORT_n_FLAGS is set by stratonto 0  after each cycle nothing else will happen.

The variable PORT_n_Flags is a bit mask for those variables which are relevant in this cycle for the
structure straton queries. In order to give a Move n degree command set the PORT_n_FLAGS variable
to a bit mask [ST]:

or UPDATE_SPEELC or UFDATE_TACHO LIMIT);

It is then defined that the data for PORT_n_MODE, PORT_n_SPEED and PORT_n_TACHOLIMIT are
available. Which values must these variables have?

For PORT_n_MODE also a bit mask is required. In principle always both must be set if you would like to
create a forward movement [ST]:

MOTORON

T BRAKE):

Now you have set the bit mask on which variables are supposed to be updated as well as some internal
flag parameters.

Now we can focus on the more interesting part: The rotation mode of the motor -
PORT_n_RUNSTATE. No bit mask is available in this case. The values are exclusive.

$define MOTOR_RUN_STATE_IDLE Motor idles / does nothing
#define MOTOR_RUN_STATE_RUNNING Moto

PORT_B_SPEE
PORT_B_TACHOLIMIT 1=
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A Attention

Make absolutely sure that these values are not written in every cycle. Otherwise the
rotation command is executed in every cycle. However, you still have to write all
variables in every cycle. Block the writing of these values.

4. zenon Science Package for LEGO MINDSTORMS EV3

The zenon Science Package for LEGO MINDSTORMS EV3 enables the programming of LEGO Mindstorms
EV3 objects.

Preparation:

» zenon 7.20 already installed and installations medium available.
If you have not installed zenon, you must install the zenon Science Package, version 7.20 or
higher.

4.1 Requirements

Hardware:

» Netgear WNA1100 Wi-Fi Dongle

» LEGO MINDSTORMS EV3 with firmware version 1.03E or 1.03H or higher.
Software:

» zenon from version 7.20 on

» LEGO MINDSTORMS EV3 Runtime (available on the installation medium in the path
\AdditionalSoftware\Science Package - Firmware\EV3)

» Bricx Command Center (available at http://bricxcc.sourceforge.net/
(http://bricxcc.sourceforge.net/))

FIRMWARE FOR LEGO MINDSTORMS EV3

The firmware on the LEGO MINDSTORMS EV3 must be at least version 1.03E or 1.03H or higher.

To check the version of the firmware, select Brick Info inthe Settings tab of LEGO MINDSTORMS
EV3. You can download the most recent firmware (*.bin file) from the LEGO website.

Use the LEGO software to update the firmware.
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4.2

Installation

The installation comprises:

>

>

>

zenon

zenon Logic Editor and Runtime

If you have already installed zenon 7.20 or higher, you can execute the EV3 setup immediately.

INSTALLATION OF THE ZENON SCIENCE PACKAGE

Start the installation from the zenon installation medium and follow the notes in the installation
assistant. You can also download the zenon from the COPA-DATA home page. This
installation already includes zenon Logic.

INSTALLATION OF STRATON RUNTIME ON LEGO EV3

1.

Install the Bricx Command Center.
You can find the program at http://bricxcc.sourceforge.net/test_releases
(http://bricxcc.sourceforge.net/test_releases).

Download a current test_release.
test_release2013007.zip is used in these instructions.

Connect the LEGO MINDSTORMS EV3 to the PC with a USB cable.
Open Bricx CC: Tools -> Find Brick

Configure the connection:

Find Brick LT
Searching for the brick
Prest Bick Typa
ush - Ev3 -
Fimwease
Shtandsnd
DS CrT
ok, Cancel Hielp

e Port: usb
e Brick Type: EV3

e  Firmware: Linux
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10.

11.

Open Bricx Explorer: Tools -> Explorer.
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zenon Science Package for LEGO MINDSTORMS EV3
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Create a new folder called T5 Runtime.

Open, on the installation medium, the folder T5 Runtime in the following
path:\AdditionalSoftware\Science Package - Firmware\EV3\apps.

Zzenon

Copy the files contained therein and add these to your T5 Runtime folder in the Brick Explorer.

Openthe \AdditionalSoftware\Science Package - Firmware\EV3\prjs folder

on the installation medium.

Copy the file there called t5ev3 to the folder in which the T5 Runtime folder is also located.
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zenon Science Package for LEGO MINDSTORMS EV3
Zenon

» Onthe ccoevseick, the new entry T5 Runtime is now available.

4.3 Create a zenon Logic project

zenon Logic contains a fully-integrated configuration tool for the eco minostorus evs, as well as a library
with Funciions and runciion slocks.

The first stage is to create a zenon project and a zenon Logic project in this.

CREATE A ZENON PROJECT

1. Open the zenon Editor
2. Select File -> New project.

3. The dialog to create a project is opened.

i
]
i (=

(=, S L]

4. Enter a name for the project.
5. Click on oxk.

e The wizard to create the project is started.
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e Close the wizard.

Alternatively, you can also open the supplied demo project.

CREATE A ZENON LOGIC PROJECT

1. Inthe zenon Editor, go to zenon Logic (IEC 61131-3).

2. Inthe context menu or in the tool bar of the detail view, select zenon Logic New project.

¥4 Fatony of changes < b
i E: s w | Otossl f 0 fitered /O selected

3. The dialog to create a project is opened.
4. Enter a name for the project.

5. Click on Fertigstellen.




zenon Science Package for LEGO MINDSTORMS EV3 ﬂ
Zenon

4.4 EV3 configuration in zenon Logic

Runtime administers an allocation table, which contains the (cco vinnstorus £va inpus and oupus. A tool for
configuration is integrated into the zenon Logic vworkbench.

To start the configuration:

1. Inthe zenon Logic workbench, double click on Field bus configuration.

£ MyEW3
3 Graphic
= Programs
3 Recipe
3 Sagnals
3 Soft Scope
3 Spy
3 String Tables
Wir Fieldbus Configurations
%4 Binding Configuration
€ Profiles
i yos
29 Global defines
3 Verishles
B Types

The 1/0 driver window is opened.
Right click on a free position in this window.

Select Add configuration in the context menu.

vk N

The add configuration window is opened.

Chooee a conbgurabion —
=

= Amdus Cancel
2 CAMN

7 DNFY

= EthemailP

2 IECE0ET0

o IECHIEED

= MODBUS

7 Frofine 10

[ Shanad Mamary

0K,

6. Select the a11 node.
7. Select LEGO EV3.

8. Click on ok.




The configuration is created in the tree view:

] LEGOEY3
B Eva

[l Buttonz

= Sensors

[l Paort0
F Part1
[l Port2
[l Port3

LEGO EV3 CONFIGURATION

>

44.1

You can define the type of sensor for each port in the Sensors group.

EV3

e  Buttons
Sensors

e Port0

e Portl

e Port2

e Port3

Define sensor type

To do this:

1.

2
3.
4

Double-click on the port.
The configuration window will open
Double-click on Type.

The selection list is opened.
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5. Select the desired type.

[ =

M ame \
: ~
Type T Sound sensor (dE)

Sound sensor (dBA)
Light sensor (active)
Light sensor (ambient)
Colour sensor
Ultrasonic sensor
Temperature sensor
Gyroscopic sesnor (HT)
Lhigital compass sensor (HT)
EW3 Gyroscopic sensor
EV3 Ultrasonic sensor
EV3 Colour sensor

6. Close the dialog by clicking on ox.

4.4.2 Create variables

You can create variables automatically or connect them manually.

CREATE VARIABLES AUTOMATICALLY

1. Right-click on the port.
2. Select create variables in the context menu.

3. All required variables are created automatically.

Note: If the sensor type is set to None, no variables are created.

CONNECT VARIABLES MANUALLY

To connect variables manually:
1. Right-click on the port.
Select Add variables in the context menu

2
3. The dialog for configuration is opened.
4

Clicking on a value opens the selection list of the values that are possible for this type.
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CONFIGURE VARIABLES

Parameter Description

Symbol Selection of a variable in accordance with IEC 61131-3 syntax.
Area Range.

Format Data type:

» 32 bit float

» Signed 16 bit integer

» Signed 32 bit integer

» Signed 8 bit integer

» Single bit

» Unsigned 16 bit integer
» Unsigned 32 bit integer

» Unsigned 8 bit integer

Offset Is not used.
Bit Number Bit number.
DATATYPES

You can connect variables with any desired data type to the LEGO EV3 1/Os. Runtime automatically
converts the values to the data type of the variable.

Note: STRING variables are not supported.

4.4.3 Blocks and Functions function

Some and are provided in the library to control LEDs, sounds, LCD and motors of the
LEGO EV3.

The following are described in more detail:
» LED
» Sound

> Motor

LED

Set LED pattern:
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SetLed Creates an LED pattern

[IN] LED Index of the LED pattern to be applied:
»  0:All LEDs off.

» 1-9: Corresponding LED pattern.

[OUT] Q Current LED pattern.

Sound

Set sound playback.

General:
PlaySnd Play back sounds.
[IN] ENABLE Switch on sound playback:
» TRUE: Sounds are played back.
To activate playback, the setting must have previously been FALSE.
) FALSE: Sounds are not played back.
[IN] FREQ Frequency of the sound.
[IN] DURATION Duration of the signal.
[IN] VOLUME Volume
>  Minimum: 0
»  Maximum: 100
[OUT] PLAYING TRUE, if sounds are played back.

System sounds:
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PlaySysSnd Play back system sound.

[IN] ENABLE Switch on sound playback:

» TRUE: Sounds are played back.
To activate playback, the setting must have previously been FALSE.

» FALSE: Sounds are not played back.

[IN] SND Index of the system sound.

[IN] VOLUME Volume.
> Minimum: 0

> Maximum: 100

[OUT] PLAYING TRUE, if a system sound is played back.
Symbol Variable name in accordance with IEC 61131-3 syntax.
Area » Data Exchange

» Data Status.

Format Data type:

» 32 bit float

» Signed 16 bit integer

» Signed 32 bit integer

) Signed 8 bit integer

> Single bit

» Unsigned 16 bit integer
» Unsigned 32 bit integer
» Unsigned 8 bit integer

Offset Is not used.
Bit Number Bit number.
Motor
Set motor.

MOTOR INFORMATION

Motor information:
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MotorInfos Call up motor information.

[IN] MOTOR Index of the motor: 1 - 4

[OUT] SPEED Current speed.

[OUT] TACHO Current number of revolutions to display the distance covered.
RUN MOTOR
Run a motor:

Rotate Run a motor.

[IN] MOTOR Index of the motor: 1 - 4

[IN] START

Start motor:

» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.

) FALSE: Motor is not started.

[IN] POWER Force to be applied:

» -255to -1:Backwards.
» 0:Stop.

» 1to255: Forward.

[OUT] RUNNING TRUE if the motor is running.

[OUT] SPEED Current speed.

Run several motors:
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Rotate2

Run several motors.

[IN] MOTORS

Index of the motor numbers.

» Motor1:1
» Motor 2: 2
» Motor 3: 4
» Motor4: 8

Example: To address Motors 1 and 2, enter 3 (1 + 2).

IN] START
[IN] Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
) FALSE: Motor is not started.
[IN] POWER Force to be applied:

-255 to -1: Backwards.
0: Stop.

1 to 255: Forward.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

ROTATION ANGLE

Rotation angle for a motor:
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RotateAngel

Rotation angle for a motor.

[IN] MOTORS

Index of the motor: 1 - 4

[IN] START Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
» FALSE: Motor is not started.
[IN] POWER Force to be applied:
» -255to -1:Backwards.
» 0:Stop.
» 1to255: Forward.
[IN] ANGLE Angle in degrees.
[IN] BRAKE Brake.

» TRUE: Motor is braked at the end.

) FALSE: Motor is not braked.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

Angle of rotation for several motors:
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RotateAngel2

Angle of rotation for several motors.

[IN] MOTORS

Index of the motor numbers.

» Motor1:1
» Motor 2: 2
» Motor3:4
» Motor4: 8

Example: To address Motors 1 and 2, enter 3 (1 + 2).

[IN] START Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
» FALSE: Motor is not started.
[IN] POWER Force to be applied:
» -255to -1: Backwards.
» 0:Stop.
» 1to255: Forward.
[IN] ANGLE Angle in degrees.
[IN] BRAKE Brake.

» TRUE: Motor is braked at the end.

) FALSE: Motor is not braked.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

SPEED

Speed for a motor:
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RotateCount

Run a motor for a defined number of counter impulses.

[IN] MOTORS

Index of the motor: 1 - 4

[IN] START Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
» FALSE: Motor is not started.
[IN] POWER Force to be applied:
» -255to -1:Backwards.
» 0:Stop.
» 1to255: Forward.
[IN] COUNT Number of rotation impulses.
[IN] BRAKE Brake.

TRUE: Motor is braked at the end.

FALSE: Motor is not braked.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

Speed for several motors:
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RotateCount2

Run several motors for a defined number of counter impulses.

[IN] MOTORS

Index of the motor numbers.

» Motor1:1
» Motor 2: 2
» Motor3:4
» Motor4: 8

Example: To address Motors 1 and 2, enter 3 (1 + 2).

[IN] START Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
» FALSE: Motor is not started.
[IN] POWER Force to be applied:
» -255to -1: Backwards.
» 0:Stop.
» 1to255: Forward.
[IN] COUNT Number of rotation impulses.
[IN] BRAKE Brake.

» TRUE: Motor is braked at the end.

) FALSE: Motor is not braked.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

RUNNING TIME

Running time for a motor:
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RotateTime

Run a motor for a defined time period.

[IN] MOTORS

Index of the motor: 1 - 4

[IN] START Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
» FALSE: Motor is not started.
[IN] POWER Force to be applied:

» -255to -1:Backwards.
» 0:Stop.
» 1to255: Forward.

[IN] SECONDS

Time that the motor runs, in seconds.

[IN] BRAKE

Brake.

» TRUE: Motor is braked at the end.

) FALSE: Motor is not braked.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

Speed for several motors:
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RotateTime2

Run several motors for a defined time period.

[IN] MOTORS
»
»
»
»

Index of the motor numbers.

Motor 1: 1
Motor 2: 2
Motor 3: 4
Motor 4: 8

Example: To address Motors 1 and 2, enter 3 (1 + 2).

4

[IN] START Start motor:
» TRUE: Motor is started. To start, the setting must have previously been
set to FALSE.
» FALSE: Motor is not started.
[IN] POWER Force to be applied:
» -255to -1: Backwards.
» 0:Stop.
» 1to255: Forward.
[IN] SECONDS Time that the motors run, in seconds.
[IN] BRAKE Brake.
» TRUE: Motor is braked at the end.

FALSE: Motor is not braked.

[OUT] RUNNING

TRUE if the motor is running.

[OUT] SPEED

Current speed.

MOTOR POWER OUTPUT

Define the power output for a motor:




zenon Science Package for LEGO MINDSTORMS EV3

Zzenon

SetPower

Define the power output for a motor whilst it is turning.

[IN] MOTORS

Index of the motor: 1 - 4

[IN] SET Define power output:
» TRUE: Power output is defined. To do this, the setting must have
previously been set to FALSE.
» FALSE: Power output is not changed.
[IN] POWER Force to be applied:

» -255to -1:Backwards.
» 0:Stop.
» 1to255: Forward.

Define power output for several motors:

SetPower2

Run several motors for a defined time period.

[IN] MOTORS

Index of the motor numbers.

> Motor1:1
»  Motor 2: 2
» Motor3: 4
» Motor4: 8

Example: To address Motors 1 and 2, enter 3 (1 + 2).

[IN] SET Define power output:

» TRUE: Power output is defined. To do this, the setting must have
previously been set to FALSE.

) FALSE: Power output is not changed.

[IN] POWER Force to be applied:
» -255to -1: Backwards.
» 0:Stop.
» 1to255: Forward.

STOP MOTOR

Stop a motor:
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StopMotor Stop a motor.

[IN] MOTOR Index of the motor: 1 - 4
IN] STOP .

[IN] Motor is stopped.

Stop several motors:

StopMotor2 Stop several motors.

[IN] MOTORS Index of the motor numbers.
> Motor1:1
»  Motor 2: 2
» Motor3: 4
» Motor4: 8

Example: To address Motors 1 and 2, enter 3 (1 + 2).

[IN] STOP

Motors are stopped.

4.5 Connect EV3 to zenon Logic Editor

LEGO MINDSTORMS EV3 and zenon Logic communicate via wi-ri.

To establish communication:
1. Insert the Netgear WNA1100 Wi-Fi Dongle into the USB port of the &rick.

2. Switch on the wiri on the LEGO MINDSTORMS EV3.
To do this:

a) Open the settings tab (tool symbol).

b) Activate the wi-Fi.




3. Connect to your network.

LN W
1, 4

You can find further information about wiri in your LEGO MINDSTORMS EV3 instructions.

4. Define the IP address of the LEGO MINDSTORMS EV3 in zenon Logic Editor.
To do this:

a) Open the Tools menu.
b) Select the communication parameters command.
c) The dialog to select the IP address is opened.

d) Select the IP address of the EV3. (See also the First steps in the demo project (on page 64)
chapter.)

Communication Settings .

| 15 Funtime -
[:]

1921681131100 -
192168.33.111:502
192 168.33.45:502
192 168,33 46:502
19216833 5502

192 168.33.88:1100

(i}

192168.73.1131100
192168.73.114:1100 |
192168.73.11%1100

19216873115 1100010) -

Ll e lan B e e Lt N 2]

Note:

- You can find the correct IP address in the ziick in the settings tab (tool symbol ) under
Brick Info.

- Runtime uses port 1100.

5. Start the T5 Runtime on the LEGO MINDSTORMS EV3.
To do this:

a) Select, in the app tab (arrow symbol) of the ziick, TS Runtime.
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b) Press the middle switch on the

c) Starts the Runtime.

You can now create a new program in the zenon Logic Workbench to control your LEGO MINDSTORMS
EV3 with the help of the program.

4.6 First steps in the demo project

You can try out the basic functions and configuration of LEGO MINDSTORMS EV3 with zenon and zenon
Logic with the supplied demo project.

To do this:

1. Open the demo project called EV3_DEMo in zenon Editor.
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2. Connect the sensors and motors to the corresponding ports.

3. Configure the zenon Logic: LEGO_EV3 driver.

CONFIGURING THE DRIVER

To configure the driver:
1. Inthe zenon project, go to the priver node (below variables).

2. Right-click on the driver zenon Logic: LEGO EV3.
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Select briver configuration in the context menu

)
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[} .
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g
gi Hi

i
:

Filter tent Filter text
* Driver for system variables | | SYSDRV
SMUL SIMUL32

New driver...
Exchange deiver...

A Driver configuration...
Import vatiables from deiver...

Createsedit simulation project
Delete timulation project

Delete
Remove all filters
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Properties
Help n
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4. The configuration window will open

5. Inthe General tab, select the Hardware entry for the Mode option.
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6. Switch to tab connections (1).

Connection name
LEGO_EV3

Addressng
Prmaey IP address
I-..-: 16172127
Secondary IP address

Ever handing
Comuncation tmeout
ms

Options
Use mutiple connectons

2 connectionn

Use evert connecton
Enabled feportaneous and poling)

Max. wite request length
512

Ignoes PLE time stamps (Bhways use Jocsl tme)

a) Highlight the LEGo_EV3 connection (2).
b) Click onEdit (3).

c) Forthe Primary IP address option, enter the IP address of your srick.
You can find the address in the siick in the settings tab (tool symbol) under Brick Info.

d) Change the Primary port no option (4) to 1100.
e) Confirm the input by clicking save (5).

7. Close the window by clicking on ok.

CONFIGURE ZENON LOGIC PROJECT AND START RUNTIME

Once you have configured the driver, open the zenon Logic project.
To do this:

1. Inthe zenon Editor, go to zenon Logic (IEC 61131-3).
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Double click on the project
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Open, in zenon Logic workvench, the Tools menu.

Click on communication parameters.
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5. The dialog to configure communication parameters is opened.
(See also Connect EV3 to zenon Logic Editor (on page 62) chapter.)

QK.
T v|

Cancel

172.16.172.127:1100 . |

Browse

Help

6. Enter the IP address of your LEGO MINDSTORMS EV3 &ick and its port number.
Format: IP address port number.
You can find the address in the siick in the settings tab (tool symbol) under Brick Info.
Port number: 1100.

7. Use straton Runtime to connect to the EV3.
to do this:

e Openthe menu Project
e Select the online entry.
e Confirm the question after downloading the project with ox.

e Load the project into the EV3.
(Alternatively: Project -> Download application.)

8. Switch to the zenon Editor

9. Inthe Runtime files tool bar, click on create all Runtime files.




zenon Science Package for LEGO MINDSTORMS EV3
zenon

10. Click on start Runtime.

File Edit Options Window Help

El- 1 Workspace: "SciencePackage_Demo_7_2003)
=-[H EV3Z_DEMO (Start project)
=4 Varables

o Driver F.T Filter test F| Fitert
# Datatypes LEGO. EV3 175,18
@ Reaction matrix

8 Mlocations
- 0TY Alarm

EV3 Runtime is started.

4.7 COPA-DATA Forum

For questions in relation to the zenon Science Package, you can also receive information and support in
the science package Thread in the COPA-DATA Forum: www.copadata.com/forums
(http://www.copadata.com/forums).
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